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บทที่ 1  
บทนำ 

 
1.1 ความเป็นมาและความสำคัญ  

ห้องสมุดคณะวิจิตรศิลป์ได้ให้บริการทรัพยากรสารสนเทศประเภทภาพยนตร์ เพ่ือสนับสนุนการเรียนรู้
ด้านศิลปะ วัฒนธรรม และวิชาการต่าง ๆ โดยคัดสรรภาพยนตร์ทั้งในและต่างประเทศที่มีเนื้อหาหลากหลาย 
เช่น ภาพยนตร์สารคดีเชิงประวัติศาสตร์ ภาพยนตร์ศิลปะและการแสดง ภาพยนตร์ชีวประวัติบุคคลสำคัญ 
ตลอดจนภาพยนตร์ที่ถ่ายทอดวิถีชีวิตและวัฒนธรรมของสังคมต่าง ๆ ทั่วโลก เพ่ือให้ผู้ใช้บริการสามารถเข้าถึง
แหล่งความรู้เชิงลึกและมุมมองที่หลากหลาย อันเป็นประโยชน์ต่อการเรียน การวิจัย และการสร้างสรรค์ผลงาน
ทางศิลปะและวัฒนธรรม 

ด้วยระบบการยืม-คืน ทรัพยากรสารสนเทศประเภทภาพยนตร์ที่มีให้บริการในห้องสมุดคณะวิจิตร
ศิลป์ยังไม่มีโปรแกรมรองรับระบบการยืม-คืน ภาพยนตร์ที่มีมาตรฐาน ห้องสมุดคณะวิจิตรศิลป์จึงได้พัฒนา
แอปพลิเคชัน Fofalib Movie ด้วยเครื่องมือออนไลน์ GlideApps เพื่อให้ผู ้ใช้บริการสามารถเข้าถึงข้อมูล
ภาพยนตร์ซึ่งเป็นทรัพยากรสารสนเทศภายในห้องสมุดได้อย่างสะดวก รวดเร็ว และแสดงผลในรูปแบบที่เข้าใจ
ง่าย เหมาะสำหรับการใช้งานบนอุปกรณ์พกพา การเลือกใช้ GlideApps ช่วยให้การออกแบบและสร้างแอป
เป็นไปอย่างง่ายดาย โดยไม่จำเป็นต้องมีความรู้เชิงลึกด้านการเขียนโปรแกรม จึงเป็นเครื่องมือที่เหมาะสม
สำหรับนักศึกษาและผู้เริ่มต้นที่สนใจพัฒนาแอปพลิเคชันด้านเทคโนโลยีดิจิทัล ทั้งนี้ การจัดทำคู่มือแนวปฏิบัติ
จะช่วยให้ผู้ปฏิบัติงานสามารถสร้าง จัดการฐานข้อมูล และเพ่ิมข้อมูลในแอปได้อย่างถูกต้องและมีประสิทธิภาพ         
เพ่ิมคุณภาพและความรวดเร็วในการให้บริการของห้องสมุด 
 
1.2 วัตถุประสงค ์

การจัดทำคู่มือแนวปฏิบัติสำหรับผู้ใช้งานระบบแอปพลิเคชัน Fofalib Movie ของห้องสมุดคณะวิจิตร
ศิลป์ มีวัตถุประสงค์ ดังนี้ 
 1.1 เพ่ือใช้เป็นคู่มือแนวปฏิบัติงานระบบแอปพลิเคชัน Fofalib Movie ของห้องสมุดคณะวิจิตรศิลป์ได้
อย่างถูกต้องและรวดเร็ว สามารถถ่ายทอดให้กับเจ้าหน้าที่ห้องสมุด ให้สามารถปฏิบัติงานทดแทนกันได้อย่าง
ถูกต้อง ไม่ก่อให้เกิดความสับสนและความเข้าใจคลาดเคลื่อน เป็นไปในแนวทางเดียวกัน 
 1.2 เพื่อให้การปฏิบัติงานภายในห้องสมุดคณะวิจิตรศิลป์ มหาวิทยาลัยเชียงใหม่ มีประสิทธิภาพและ
ประสิทธิผลเป็นไปตามวัตถุประสงค์ของส่วนงาน ลดข้อผิดพลาดในการปฏิบัติงาน 
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1.3 ขอบเขต 
ขอบเขตของคู่มือนี้ครอบคลุมตั้งแต่ ประเภทของทรัพยากรสารสนเทศประเภทภาพยนตร์ภายในห้องสมุด

คณะวิจิตรศิลป์ มหาวิทยาลัยเชียงใหม่ ขั้นตอนการสร้างแอปพลิเคชัน Fofalib Movie ด้วย GlideApps ตั้งแต่
การเริ่มต้นสร้างโปรเจกต์ การออกแบบและจัดทำตารางฐานข้อมูลเพื่อจัดเก็บข้อมูลภาพยนตร์ ไปจนถึงการ
เพิ่มข้อมูลจริงลงในแอปพลิเคชัน เพื่อให้ผู้ใช้งานสามารถสร้างและจัดการแอปพลิเคชันได้อย่างครบถ้วนและ   
มีประสิทธิภาพ 

 

1.4 คำจำกัดความ 
Admins หมายถึง เจ้าหน้าที่ห้องสมุดคณะวิจิตรศิลป์ 
แอปพลิเคชัน หมายถึง โปรแกรมหรือชุดคำสั่งที่ใช้ควบคุมการทำงานของ

คอมพิวเตอร์ โทรศัพท์เคลื่อนที่ และอุปกรณ์ต่อพ่วง
ต่าง ๆ ให้ทำงานได้ตามที่สั่ง ในที่นี้สามารถหมายถึง 
แอปพลิเคชัน Fofalib Movie 

ฐานข้อมูล หมายถึง พ้ืนที่จัดเก็บข้อมูลภาพยนตร์ของห้องสมุดคณะวิจิตร
ศิลป์ 

Fofalib Movie หมายถึง ชื่อระบบแอปพลิเคชันสำหรับใช้บริการยืม-คืน 
ภาพยนตร์ของห้องสมุดคณะวิจิตรศิลป์ 

 
1.5 หน้าที่ความรับผิดขอบ 
    1.5.1 เจ้าหน้าที่ห้องสมุดคณะวิจ ิตรศิลป์ มีหน้าที่จ ัดหาทรัพยากรสารสนเทศหนังสือ และ
ผู้ปฏิบัติงานขั้นตอนการจัดซื้อทรัพยาการสนเทศประเภทหนังสือ  
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บทที่ 2 
ขั้นตอนการปฏิบัติงาน 

 

2.1 ประเภทของทรัพยากรสารสนเทศประเภทภาพยนตร์ภายในห้องสมุดคณะวิจิตรศิลป์ มหาวิทยาลัยเชียงใหม่ 
“ทรัพยากรสารสนเทศประเภทภาพยนตร์” จัดอยู่ในทรัพยากรสารสนเทศรปูแบบ วัสดุไม่ตีพิมพ์ เป็น

ทรัพยากรสารสนเทศที่สื่อความหมายโดยผ่านทางประสาทหู และตา เป็นวัสดุสารสนเทศที่ไม่อยู่ในรูปแบบ
ของตัวพิมพ์ และสามารถสื่อความหมายของข้อมูลที่บรรจุอยู่ได้โดยอาศัยภาพและเสียงเป็นหลัก  ช่วยให้เกิด
การเรียนรู้ได้เร็ว เข้าใจง่าย และชัดเจนยิ่งขึ้น (ห้องสมุดโรงเรียนเฉลิมพระเกียรติพระศรีนครินทร์ ภูเก็ต, 2558)  

ห้องสมุดคณะวิจิตรศิลป์ได้เล็งเห็นถึงคุณค่าของภาพยนตร์ในฐานะสื่อการเรียนรู้ที่สามารถเชื่อมโยง
ข้อมูล ความรู้ และแรงบันดาลใจให้แก่ผู้ใช้บริการ จึงได้ดำเนินการส่งเสริมและให้บริการทรัพยากรสารสนเทศ
ประเภทภาพยนตร์ตั้งแต่ปี พ.ศ. 2550 จนถึงปัจจุบัน โดยคัดสรรภาพยนตร์ที่มีคุณภาพและหลากหลาย เพ่ือ
รองรับความต้องการใช้งานทั้งด้านการศึกษา วิจัย และการเสริมสร้างทักษะความคิดสร้างสรรค์  สำหรับ
ทรัพยากรสารสนเทศประเภทภาพยนตร์ที่ให้บริการภายในห้องสมุด สามารถจำแนกออกเป็น 3 ประเภทหลัก 
ได้แก่ 

2.1.1 ภาพยนตร์ไทย คือ ภาพยนตร์ที่สร้างโดยผู้ผลิตในประเทศ ซึ่งมีทั้งผลงานที่ถ่ายทอดเรื่องราว
ทางประวัติศาสตร์ ศิลปวัฒนธรรม วิถีชีวิตท้องถิ่น ตลอดจนภาพยนตร์ร่วมสมัยที่สะท้อนมุมมองและค่านิยม
ของสังคมไทย เหมาะสำหรับการศึกษาและทำความเข้าใจรากฐานทางวัฒนธรรมและความคิดสร้างสรรค์ของ
คนไทย 

2.1.2 ภาพยนตร์ต่างประเทศ ประกอบด้วยภาพยนตร์จากหลากหลายประเทศและภูมิภาคทั่วโลก 
ครอบคลุมทั้งภาพยนตร์ศิลปะ ภาพยนตร์คลาสสิก และภาพยนตร์ร่วมสมัย ซึ่งช่วยเปิดมุมมองผู้ชมให้กว้างขึ้น 
ทำความเข้าใจความหลากหลายของวัฒนธรรม สังคม และประวัติศาสตร์ในระดับนานาชาติ 

2.1.3 สารคดี คือ ภาพยนตร์เชิงข้อเท็จจริงที ่มุ ่งนำเสนอข้อมูล ความรู ้ และประสบการณ์จาก
เหตุการณ์ บุคคล หรือสถานที่จริง ครอบคลุมหัวข้อหลากหลาย เช่น ศิลปะ ประวัติศาสตร์ วิทยาศาสตร์ 
ธรรมชาติ และสังคม เหมาะสำหรับใช้ประกอบการเรียนการสอน งานวิจัย และการศึกษาด้วยตนเอง เพ่ือ
เพ่ิมพูนความรู้และความเข้าใจในประเด็นต่าง ๆ อย่างรอบด้าน 
  เพ่ือให้การเข้าถึงทรัพยากรสารสนเทศประเภทภาพยนตร์ทั้ง 3 ประเภท ของห้องสมุดคณะวิจิตรศิลป์
มหาวิทยาลัยเชียงใหม่ (ภาพยนตร์ไทย ภาพยนตร์ต่างประเทศ และภาพยนตร์สารคดี) เป็นระบบและสะดวก
สำหรับผู้ใช้บริการ ห้องสมุดฯ จึงได้พัฒนาแอปพลิเคชัน Fofalib Movies บนแพลตฟอร์ม GlideApps ซึ่ง
รองรับการค้นหา เรียกดู และอัปเดตข้อมูลได้บนอุปกรณ์พกพาอย่างเข้าใจง่าย โดยในส่วนถัดไปจะอธิบาย 
“วิธีการทำแอป” ตั้งแต่การตั้งค่าโปรเจกต์ การออกแบบตารางฐานข้อมูลสำหรับทั้งสามประเภท ไปจนถึง
ขั้นตอนการเพ่ิมข้อมูลจริงในแอป เพ่ือให้ผู้ปฏิบัติงานสามารถนำไปใช้งานได้ทันทีอย่างมีประสิทธิภาพ 
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2.2 วิธีการทำแอปพลิเคชัน Fofalib Movies จาก GlideApps 
 2.2.1 โครงสร้างของ Fofalib Movie 
 

   

2.2.2 ขั้นตอนการทำ Fofalib Movie 
1) การทำหน้า User Profile 

โดยหน้า User Profile จะเชื่อมโยงกับฐานข้อมูล Admins ซึ่งในขั้นตอนแรกนั้นจึงจำเป็น 
ต้องกำหนดตารางฐานข้อมูล Admin ขึ้นมาก่อน 

1.1) ฐานข้อมูล Admins ส่วนประกอบของฐานข้อมูล Admins ประกอบไปด้วย 
ตาราง และ ฟิลด์ (Field) ซึ่งข้อมูลที่ใช้เก็บใน ฟิลด์ ของ Admins ประกอบไปด้วย  

- Name = ชื่อบุคคล 
- Email = ข้อมูล Email ที่สามารถติดต่อได้ 
- Image = รูปภาพโปรไฟล์ 
- Role = สถานะ Admin / Member 
- Tel = เบอร์โทรที่สามารถติดต่อได้ 
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ฐานข้อมูลตาราง Admins โดยฐานข้อมูล Admins มีไว้ใส่ข้อมูลของ ผู้ดูแลระบบ และ
ข้อมูลของสมาชิก มีข้ันตอน ดังนี้  

• เลือก เมณู Data > +Blank Table จะได้ตารางเปล่าขึ้นมา ทำการตั้งชื่อตาราง Admins 
• ทำการตั้งชื่อตาราง Admins และสร้างตารางฐานข้อมูล Admins จะประกอบไปด้วย Name, Email, 

Image, Role และ Tel 
 

 
 

2) หน้า User Profile โดยหน้า User Profile จะแบ่งเป็น 2 หน้า คือ หน้าสำหรับ Admin 
และ สำหรับ Member 

 

      
 
 



6 

คู่มือแนวปฏบิัติสำหรับผู้ใช้งานระบบแอปพลิเคชัน Fofalib Movie ของห้องสมุดคณะวิจิตรศิลป์ 
หน่วยบรกิารห้องสมุด งานบรกิารการศึกษาและพัฒนาคุณภาพนักศึกษา คณะวิจิตรศิลป์ มหาวิทยาลัยเชียงใหม ่

2.1) หน้าจอ Admin 
ประกอบไปด้วย Header โลโก ชื่อแอปพลิเคชั่น ข้อมูลของสมาชิก ได้แก่ ชื่อ เบอร์โทร 

และอีเมลล์ ของสมาชิกทุกคน มีข้ันตอนดังนี้ 
2.1.1) ส่วน Title 

• ไปที่หน้า Layout กดตรง User Profile 
• เพ่ิม Container เมนู Componants ที่อยู่ด้านซ้ายมือ 
• ทำการใส่ชื่อ Container เป็น Container Admin 
• เพ่ิมTitle ใน container เลือกแบบ Cover 
• จัดการออกแบบส่วน Title โดยไปแถบเมนูด้านขวามือ ตรง General ทำ

การเปลี่ยนข้อมูลตรง Data ซึ่งรายละเอียดของการแสดงผลของ Title ประกอบไปด้วย โลโก้ Header และชื่อ
แอปพลิเคชั่น 
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2.1.2 ส่วน Custom Collection 

จะเห็นได้ว่าส่วนประกอบถัดไปจะประกอบไปด้วยการแสดงผลของข้อมูลของ 
Member ทุกคน ซึ่งมีรายละเอียดดังนี้  

• ชื่อของ Member  
• ไอคอน โทรศัพท์ เพื่อเชื่อมโยงไปยัง เบอร์โทรศัพท์ ของ Member ในแถว 

Tel ของตารางฐานข้อมูลของสมาชิกคนนั้นๆ เมื่อกดตรงไอคอนจะสามารถติดต่อโทรออกได้ 
• รูปไอคอนซองจดหมายซึ ่งเชื ่อมโยงไปยัง Email ของ Member ในแถว 

Email ของสมชิกคนนั้นๆ เมื่อกดตรงไอคอนจะสามารถติดต่อไปยังอีเมลล์ Member นั้นได ้
 

 
 

• ใส่ Custom Collection ใน Container Admin เพ่ือใช้แสดงผลของข้อมูล 
Member ทุกรายการ สังเกตตรง Custumer General >Data > Source ต้องเป็น ตาราง Admins เนื่องจาก
เป็นการแสดงผลที่มีการเชื่อมต่อจากฐานข้อมูลตาราง Admin 

• ตั้งค่า Layout Custom Collection โดย 
- เลือกแบบ Grid 

2.1.3 ส่วน Contact 
เป็นส่วนประกอบที่เพิ่มในส่วนของ Custom Collection เพื่อเป็นการเพ่ิม

ฟังก์ชั่นการทำงานให้กับ ส่วน Custom Collection โดยเป็นการเชื่อมต่อข้อมูลไม่ว่าจะเป็น ชื่อ เบอร์โทร 
หรือ อีเมลล์ ให้สามารถแสดงผล โทรออก หรือ ส่งอีเมลล์ เมื่อใช้งานแอปพลิเคชั่นได้ มีข้ันตอน ดังนี้ 
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• ตั้งค่า Contact โดย 

- Text = A Name 
- Label = UserProfile 
- Image = Photo 

• ตั้งค่า Action Contect ไปที่เมนูด้านขวามือ Action Contact General 
จากนั้นให้ไปท่ีคำสั่ง Action เลือก Action มาสองคำสั่ง และทำการตั้งค่า ดังนี้ 
คำสั่งที่ 1 เพื่อดึงข้อมูลการแสดงผลเบอร์โทร ในตารางฐานข้อมูล Admin ฟิลด์ Tel 

Title = Call 
Phone Number = Tel 

คำสั่งที่ 2 เพื่อดึงข้อมูลการแสดงผล Email ในตารางฐานข้อมูล Admin ฟิลด์ Email 
Title = Email 
To = @ Email 
*** สามารถเลือกรูปแบบไอคอนได้ตามความเหมาะสม ตรง Icon 

 

 
 

• เมื่อทำส่วนนี้เสร็จแล้ว สามารถเพิ่มในฐานข้อมูล Admins ได้เลย และให้
กำกับตรง แถว Role ว่า Admin หรือ Member ข้อมูลจะแสดงผลในแอปพลิเคชั่นโดยอัตโนมัติ 
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การตั้งค่าการแสดงผลหน้าแอปพลิเคชั่น การตั้งค่าการมองเห็นให้สามารถเห็นได้เฉพาะ Admin ทำได้โดย 
• ไปตรงที่ Cotainer Admin > Container > Option > Visibility 
• และทำการตั้งค่า Visibility โดยเลือกเป็น A Role > is >Admin 
เพียงเท่านั้นหน้านี้ก็จะเห็นได้เฉพาะรายชื่อที่ระบุในแถว Role ว่า Admin 
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2.2) หน้า UserProfile Member  
หน้า Member จะดึงของมูลจากฐานข้อมูลตาราง Admins โดยหน้า Member จะมี

องค์ประกอบส่วน Title เช่นเดียวกันกับส่วนของ Admin แต่การแสดงผลรายละเอียดด้านล่างจะมีการ
เปลี่ยนแปลงไป คือ จะแสดงผลเฉพาะข้อมูลส่วนตัวของตนเองเท่านั้น ซึ่งมีข้ันตอนการทำดังนี้ 

• ทำ Container อีกหนึ่งอันต่อจาก Container Admin เพ่ือเก็บข้อมูลการแสดงผล 
• สำหรับหน้า Member ตั้งชื่อว่า Container Member 
• ใส่ข้อมูลและตั้งค่า Title เหมือน Title หน้า Admin ทุกประการ 
• มีส่วนเพิ่มมาคือ Image และ Fields 

 
 

2.2.1 ส่วน Image เอาไว้สำหรับการใส่ภาพของMember โดยจะใส่ลิงค์ภาพใน
ฐานข้อมูล ตารางAdmin ฟิลด์ Image 

2.2.2 ส่วน Fields เอาไว้สำหรับแสดงข้อมูลของสมาชิกคนนั้นๆ โดยมีการดึงข้อมูล
มาจากฐานข้อมูลตาราง Admins ซึ่งมีการตั้งค่า ดังนี้ 

• ไปที่ Fields จากนั้นไปดูที่คำสั่ง Field General ตรงขวามือ  
- ตั้งค่า Data  

Title = Member 
- ตั้งค่า Options 

Customer ใส่ Email = @ Email 
Customer ใส่ Tel = Tel 
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การตั้งค่าการแสดงผลหน้าแอปพลิเคชั่น  
การตั้งค่าการมองเห็นให้สามารถเห็นได้เฉพาะ Memder ทำได้โดย 
• ไปตรงที่ Cotainer Member > Container > Option > Visibility 
• และทำการตั้งค่า Visibility โดยเลือกเป็น A Role > is >Member 
เพียงเท่านั้นหน้านี้ก็จะเห็นข้อมูลได้เฉพาะบุคคลในชื่อที่ระบุในแถว Role  
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2.3) หน้า Items  
เมื่อเข้าแอปพลิเคชั่น Fofalib Movie จะปรากฏหน้า Items ซึ่งเป็นหน้าที่แสดงผล

ข้อมูลภาพยนตร์ทั้งหมดของ ห้องสมุดคณะวิจิตรศิลป์ มหาวิทยาลัยเชียงใหม่ ปัจจุบันมีรายการภาพยนตร์ทั้ง 
CD และ DVD 848 รายการ โดยมีการจัดการข้อมูลดังนี้ 

2.3.1) สร้างฐานข้อมูล Items 
• ทำตารางฐานข้อมูล Items ซึ ่งข้อมูลมาจาก ทะเบียนภาพยนตร์ในรูป

แบบเดิมที่ทางห้องสมุดได้มีการทำไว้ คือ แบบไฟล์ Microsoft Word และเอกสารรูปเล่ม 
• นำข้อมูลมาใส่ใน ฐานข้อมูลตาราง Items ใน www.Glideapps.com ซึ่ง

รายละเอียดการลงข้อมูลได้ทำเป็นคู่มือในลิงค์เพื่อใช้ในการกรณีศึกษาสำหรับผู้ดูแลระบบต่อไปภายภาคหน้า  
การใส่ข้อมูลในแอปพลิเคชั่น Fofalib Movie  
 

 
 

http://www.glideapps.com/
https://www.canva.com/design/DAGQh5OifOw/0PLYe1E5ucEeheC8WyOx9w/edit?utm_content=DAGQh5OifOw&utm_campaign=designshare&utm_medium=link2&utm_source=sharebutton
https://www.canva.com/design/DAGQh5OifOw/0PLYe1E5ucEeheC8WyOx9w/edit?utm_content=DAGQh5OifOw&utm_campaign=designshare&utm_medium=link2&utm_source=sharebutton
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2.3.2) การสร้างหน้า Items หน้าที่ 1 
หน้า Itemsจะมีการเชื่อมโยงกับฐานข้อมูลตาราง Items มีข้ันตอนการทำ ดังนี้ 
• ไปที่เมนู Layout สร้าง Navigation หน้า Items ขึ้นมา 
• จากนั้นให้ไปที่คำสั่งด้านขวามือจะขึ้น เมนูการจัดการ Navigation Items 

ขึ้นมาโดยการไปที่ เครื่อหมาย + > Screen form data > Item ข้อมูลจะถูกเชื่อมต่อกับฐานข้อมูลตาราง 
Item โดยอัตโนมัติ 

• ให้ไปที่ General > Sourse = Items เพื่อดึงข้อมูลจากฐานข้อมูล Items 
มาแสดงผลหน้านี้ 
 

 
 

• จากนั้นทำการตั้งค่า Collection เพื่อตั้งค่าการแสดงผลของข้อมูลภาพ
ยนตร์ในหน้า Interface ของแอปพลิเคชั่น 

• เลือกรูปแบบ Card เพราะรายการมีจำนวนมาก และต้องการแสดงผล
ข้อมูลของรายการที่มีความเข้าใจง่ายสะดวกต่อการอ่านข้อมูลของผู้ใช้งานจึงมีเพียงการแสดงผลแค่ ชื่อ
ภาพยนตร์ รูปภาพ ชนิด และทะเบียนเท่านั้น 
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• ตั้งค่า Items Data ดังนี้ 
- Title = A name เพ่ือจะดึงข้อมูลในตาราง Items แถว A name มาแสดงผล 
- Description = Description เพ ื ่อจะด ึงข ้อม ูลในตาราง Items แถว 

Description มาแสดงผล 
- Image = Image เพ่ือจะดึงข้อมูลในตาราง Items แถว Image มาแสดงผล 

• ตั้งค่า Action  
- ปิด Allow user to add Items 
- ปิด Allow user to Edit Items 
- ปิด Allow user to delete Items 

• ตั้งค่า Design ดังนี้ (สามารถปรับเปลี่ยนได้ตามความเหมาะสมของข้อมูล) 
- Stlye = Minimal 
- Size = M 
- Image = Sgure 
- Aspect Radio = อันที่ 2 นับจากซ้ายมือ 
- Orientation = Vertical 
- Title stly = Bold 

• ตั้งค่า Options ดังนี้  (สามารถปรับเปลี่ยนได้ตามความเหมาะสมของข้อมูล) 
- Page size = 24 
 

 
 

2.3.3) การสร้างหน้า Items หน้าที่ 2 จะเห็นได้ว่าเมื่อทำการเลือกภาพยนตร์หน้า 
Items ในรายการ รายการหนึ่ง จะมีหน้าถัดไปซึ่งหน้านี้จะแสดงผลรายละเอียดของ Item และเป็นหน้า
เชื่อมโยงไปยังหน้า ยืมได้ โดยมีขั้นตอนการทำดังต่อไปนี้ 
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• ไปที่เมนู Compoments ด้านซ้ายมือ และเพ่ิมรายการดังต่อไปนี้นี้ 
- เพ่ิมเมนู Title การตั้งค่าดังนี้ 
- รูปแบบ Image 
- Title = A name เพื่อดึงข้อมูลในตาราง Admins แถว(ฟิลด์)  A name 

มาแสดงผล 
-  Subtitle = A Description  เพ ื ่ อด ึ งข ้อม ูลในตาราง   Admins แถว

(ฟิลด์)  A Description มาแสดงผล 
- Image = Image เพื่อดึงข้อมูลในตาราง  Admins แถว(ฟิลด์) Image มา

แสดงผล 
 - Button = ไปหน้า ยืม 

 

 
 

• ตั ้งค ่าการแสดงผลของ Field ซึ ่ง Field เป ็นส ่วนประกอบของหน้า 
แอปพลิเคชั่นในการแสดงผลรูปแบบของข้อมูล มีการตั้งค่ารูปแบบของ Field General ดังนี้ 

- ตั้งค่า Options เพื่อให้การแสดงผลข้อมูลของ Feild มี ชื่อภาพยนตร์ 
ทะเบียน  และประเภท โดยมีการกำหนดค่าดังต่อไปนี้ 

- A Name = A Nama  คือ ชื่อภาพยนตร์ 
- Description = A description คือ ทะเบียน ภาพยนตร์ 
- Type = A Type คือ ประเภทของทรัพยากร ( CD / DVD)  

 
 



16 

คู่มือแนวปฏบิัติสำหรับผู้ใช้งานระบบแอปพลิเคชัน Fofalib Movie ของห้องสมุดคณะวิจิตรศิลป์ 
หน่วยบรกิารห้องสมุด งานบรกิารการศึกษาและพัฒนาคุณภาพนักศึกษา คณะวิจิตรศิลป์ มหาวิทยาลัยเชียงใหม ่

 
 

• Button 
เป็นปุ่มที่เอาไว้เชื่อมต่อไปยังหน้าของการยืม โดยมีขั้นตอนการทำดังนี้ 
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• เลือก Button จาก Componants  
• จากนั้นด้านขวามือ ดูตรงที่ Button General  
• ตั้งค่าตรง Action จะมีคำสั่ง Show notification 
• เปลี่ยน ตรง Title เป็น ยืม  
• เลือก Action For Items > Create new action 
• จากนั้นจะปรากเป็นหน้า Untitled Action ขึ้นมา จากนั้น กดตรง Show notifiction สังเกตด้านซ้าย 

มีคำสั่ง Configure Action แก้ไข  
เป็น Navigation > Show new screen  
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• เลือก ตรง Data เป็นตาราง ยืม 
• กด Done เสร็จสิ้นกระบวนการเชื่อมต่อ ระหว่างปุ่มกด ไปยัง หน้า Navigation ยืม และเชื่อมต่อไป

ยังฐานข้อมูลตาราง ยืม 
 

 
 

2.4) หน้ายืม 
หน้ายืมเป็นหน้าที่เชื่อมต่อระหว่างปุ่มยืมในหน้าที่ 2 ของ Items ไปยัง หน้าสำหรับ

กรอกข้อมูลรายละเอียดการยืม เมื่อมีการกรอกเสร็จแล้วระบบจะนำข้อมูลไปเก็บไว้ในฐานข้อมูลตารางยืม โดย
อัตโนมัติ 

 

 
 

หน้ายืม มีขั้นตอนการทำดังนี้ 
• สร้างตารางฐานข้อมูล ยืม โดยมีการกำหนด ฟิล์ด ดังนี้ 

- Name = เก็บข้อมูลชื่อของผู้ยืม 
- Date = เก็บ เวลาและวันที่  
- ชื่อเรื่อง = เก็บข้อมูลชื่อของภาพยนตร์ 
- บาร์โค้ด = เก็บทะเบียนของภาพยนตร์ 



19 

คู่มือแนวปฏบิัติสำหรับผู้ใช้งานระบบแอปพลิเคชัน Fofalib Movie ของห้องสมุดคณะวิจิตรศิลป์ 
หน่วยบรกิารห้องสมุด งานบรกิารการศึกษาและพัฒนาคุณภาพนักศึกษา คณะวิจิตรศิลป์ มหาวิทยาลัยเชียงใหม ่

 
 

• ในขณะนี้เมื่อมีการเชื่อมโยงในส่วนของ Untitled Action ระหว่างตัว Button กับ หน้ายืมไปแล้ว 
เมื่อทำการคลิ๊กปุ่มยืม ระบบจะขึ้นหน้ายืมเปล่าๆมาให้ 

 

 
 

• เพ่ิมรายการเมนูที่ Componants เมนูทางซ้ายมือ 
• เลือก Form Container มาใ่ส่ ลบรายการที่อยู่ใน Form Cotainer ออก และตั้งค่า โดย  

- ให้เลือกเครื ่องหมายบวก ด้านซ้าย จากนั ้นให้เลือก Form element > Text Entry ขึ ้นมา 3 
รายการ และเลือก Date time 1 รายการ 

- ตั้งค่า General > Data > Column = ชื่อฟิลด์ที่จะนำข้อมูลใส่ โดย 
            Text Entry ชื่อผู้ยืม = Column A Name 
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Text Entry ชื่อเรื่อง = Column ชื่อเรื่อง 
Text Entry บาร์โค้ด = Column บาร์โค้ด  
Date time Date = Column Date เพื่อสะดวกในการกรอกข้อมูล วัน / เวลา ที่ยืม จะสามารถวัน

เวลาได้อัตโนมัติ ดังภาพ 
- ตั้งค่า Design > Label = ชื่อรายการ 

• จะปรากฏช่องรายการให้กรอกข้อมูลการคืนได้ในแอปพลิเคชั่น เมื่อมีการกรอกรายละเอียดแล้วข้อมูล
จะถูกเก็บไว้ในฐานข้อมูลตารางยืม อัตโนมัติ 
 

 
 
ตัวอย่างการตั้งค่า Text Entry 
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ระบบการยืม เมื่อมีการกรอกรายละเอียดแล้วข้อมูลจะถูกเก็บไว้ในฐานข้อมูลตารางยืม อัตโนมัติ 
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2.5) หน้าคืน 
2.5.1) สร้างตารางฐานข้อมูล คืน โดยมีการกำหนด ฟิล์ด ดังนี้ 

• Name = เก็บข้อมูลชื่อของผู้ยืม 
• Date = เก็บ เวลาและวันที่  
• ชื่อเรื่อง = เก็บข้อมูลชื่อของภาพยนตร์ 
• บาร์โค้ด = เก็บทะเบียนของภาพยนตร์ 
 

 
 

• เพ่ิม Navigation ในเมนูทางซ้ายมือ กดเครื่องหมายบวก ไปยัง Screen from data > เลือก คืน ดัง
ภาพด่านล่าง 
 

 
 
 
 
 



23 

คู่มือแนวปฏบิัติสำหรับผู้ใช้งานระบบแอปพลิเคชัน Fofalib Movie ของห้องสมุดคณะวิจิตรศิลป์ 
หน่วยบรกิารห้องสมุด งานบรกิารการศึกษาและพัฒนาคุณภาพนักศึกษา คณะวิจิตรศิลป์ มหาวิทยาลัยเชียงใหม ่

• ขั้นตอนจัดการหน้า คืน ให้เลือก ปุ่มยืม ที่โชว์ในหน้า Items จะขึ้นหน้าที่มีชื่อว่า คืน ขึ้นมาเป็นหน้า
เปล่า ซึ่งในขณะนี้สามารถจัดการ ใส่ช่องรายการการกรอกข้อมูลการคืนได้  

 
 

• ไปที่ Componants > Collection คืน เมนูทางซ้าย ด้านขวาจะขึ้น เมนู General  
• ตรวจสอบตรง Taget Table ว่า เป็นตารางคืน หรือไม่ ถ้าไม่ให้ทำการเปลี่ยน แต่ถ้าขั้นตอนการเลือก

ตารางในขั้นตอน Navigation สร้างหน้า คืนถูกต้อง ระบบจะเปลี่ยนให้อัตโนมัติ 
• เพ่ิมรายการเมนูที่ Componants เมนูทางซ้ายมือ 
• เลือก Form Container มาใ่ส่ ลบรายการที่อยู่ใน Form Cotainer ออก และตั้งค่า โดย ให้เลือก

เครื่องหมายบวก ด้านซ้าย จากนั้นให้เลือก Form element > Text Entry ขึ้นมา 3 รายการ และเลือก Date 
time 1 รายการ 

• ตั้งค่า General > Data > Column = ชื่อฟิลด์ที่จะนำข้อมูลใส่ โดย 
- Text Entry ชื่อผู้ยืม = Column A Name 
- Text Entry ชื่อเรื่อง = Column ชื่อเรื่อง 
- Text Entry บาร์โค้ด = Column บาร์โค้ด  
- Date time Date = Column Date เพ่ือสะดวกในการกรอกข้อมูล วัน / เวลา ที่คืน จะสามารถวัน

เวลาได้อัตโนมัติ ดังภาพ 
- ตั้งค่า Design > Label = ชื่อรายการ  

• จะปรากฏช่องรายการให้กรอกข้อมูลการคืนได้ในแอปพลิเคชั่น มื่อมีการกรอกรายละเอียดแล้วข้อมูล
จะถูกเก็บไว้ในฐานข้อมูลตารางยืม อัตโนมัติ 
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โดยหน้าคืนจะแยกส่วนออกเป็น เมณูด่านล่าง และจะเปิดให้เฉพาะ Admin ได้สามารถทำการกรอก
ข้อมูลการคืนได้เท่านั้น ซึ่งมีข้ันตอนดังนี้ 
 

การตั้งค่าการแสดงผลหน้าแอปพลิเคชั่น  
• การตั้งค่าการมองเห็นให้สามารถเห็นได้เฉพาะ Admin ทำได้โดย 

- ไปตรงที่ Form Container ของหน้าคืน > Option > Visibility และทำการตั้งค่า Visibility โดย
เลือกเป็น A Role > is > Admin เพียงเท่านั้นหน้านี้ก็จะเห็นข้อมูลได้เฉพาะบุคคลในที่ระบุว่า Admin ในแถว 
Role  
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2.6) หน้า Categories 
หน้า Categories เม ื ่อเข ้าแอปพล ิเคช ั ่น Fofalib Movie จะปรากฏแถบเมนู 

Categories ซึ่งเป็นหน้าที่แสดงการจัดหมวดหมู่ของภาพยนตร์ไว้เป็นหมวดหมู่เพื่อให้ผู ้ใช้สามารถดูเป็น
แนวทางในการหาภาพยนตร์ในหมวดหมู่ตามความสนใจได้ การจัดหมวดหมู่ของภาพยนตร์มี 23 หมวดหมู่ 
ได้แก่ 
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ขั้นตอนการทำหน้า Cetagories มีดังนี้  
• จัดทำแถวในฐานข้อมูลตาราง Items เพ่ิมแถวที่มีชื่อว่า Categories และใส่หมวดหมู่ของภาพยนตร์ไว้

ตรงคอลัมน์ภาพยนตร์แต่ละเรื่อง ดังภาพด่านล่าง 
 

 
 

• ไปที่เมนู Layout เพ่ิม Navigation >Screen from  date > Items เพ่ือดึงข้อมูลจากตาราง
ฐานข้อมูล Items มาใช้ในหน้านี้ ดังภาพด่านล่าง  
 

 
 
 
 



27 

คู่มือแนวปฏบิัติสำหรับผู้ใช้งานระบบแอปพลิเคชัน Fofalib Movie ของห้องสมุดคณะวิจิตรศิลป์ 
หน่วยบรกิารห้องสมุด งานบรกิารการศึกษาและพัฒนาคุณภาพนักศึกษา คณะวิจิตรศิลป์ มหาวิทยาลัยเชียงใหม ่

• ไปที่เมนู Componants ด้านซ้ายมือ เพิ่มเมนู Table ลงไป จากนั้นทำการตั้งค่า General Table 
ทางขวามือ เพ่ือตั้งค่าการแสดงผลของข้อมูล ซึ่งมีการตั้งค่าดังนี้ 
 

 
 
ไปที่ General การตั้งค่ามีดังนี้ 

• ตั้งค่า Data 
- Source = Items เพ่ือดึงข้อมูลจากตาราง Items มาใช้ 
- Type = Categories เพ่ือตั้งชื่อหน้า 

• ตั้งค่า Stlye = Table เพ่ือการแสดงผลที่ให้ดูง่ายต่อการจัดหมวดหมู่ 
• ตั้งค่า Column  

- Name = A name เพ่ือดึงข้อมูลการแสดงผลจากตาราง Items แถว A name มาใช้ 
- Image = Image เพ่ือดึงข้อมูลการแสดงผลจากตาราง Items แถว Imageมาใช้ 
-  Descriptions = A description เ พ ื ่ อ ด ึ ง ข ้ อ ม ู ล ก า ร แสด งผลจ ากตา ร า ง  Items แถว  A 

description  มาใช้ 
- Type = A type เพ่ือดึงข้อมูลการแสดงผลจากตาราง Items แถว A type  มาใช้ 

• จากนั้นตั ้งค่าที ่ Options เพื ่อที ่จะทำให้ข้อมูลมีการแสดงผลกันเป็นหมวดหมู่ตามที ่ได้กำหนด
หมวดหมู่ใน ตารางฐานข้อมูล Items แถว Categories ซึ่งสามารถทำได้โดย 
- ตั้งค่าที่ Options > Group  
- Group by = A Categories ดังภาพด้านล่าง 
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2.3 วิธีการเพิ่มข้อมูลในแอปพลิเคชัน Fofalib Movies จาก GlideApps 
 2.3.1 ขั้นตอนการทำตารางฐานข้อมูล 

• ใช้ Microsoft Excel หรือ Google Sheet ในการออกแบบตารางฐานข้อมูล 
• โดยตารางจะมีข้อมูลรายการดังต่อไปนี้ 

- Title / ชือเรื่อง 
- A Description / รายละเอียด (ระบุเลขทะเบียนทรัพยากร) 
- Type / ประเภท (ระบุประเภทของทรัพยากร เช่น CD, DVD, VDO เป็นต้น) 
- Image / ภาพ (ใส่เป็นลิงค์ของภาพ) 

 

 
 

• นำข้อมูลของทรัพยากรใส่ลงไปในตารางรายการที่ทำไว้ 
• เมื่อทำเสร็จแล้วให้ทำการบันทึกเป็นไฟล์ Excel Workbook 
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2.3.2 ขั้นตอนการเพ่ิมข้อมูลในแอปพลิเคชัน 
• เข้าไปที ่https://www.glideapps.com/ 
• เข้าไปที่ Log in 

 
 

• กรอกอีเมลล์ และกดตรงที่ Sign in with E-mail 

 
 
 
 

https://www.glideapps.com/
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• กรอกชื่อ และกดเลือก Fofalib’s App (เนื่องจากคู่มือนี้ใช้ในการลงข้อมูลรายการเพิ่มเติม
หลังจากมีการพัฒนาแอฟพลิเคชั่นก่อนหน้านี้แล้ว) เพ่ือเข้าไปเเก้ไขเเละเพ่ิมข้อมูลในเเอพลิเคชัน 
 

 
 

• กดเลือก Data เพื่อทำการเพิ่มข้อมูล 
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• กด Import เพื่อลงไฟล์ Excel ข้อมูลทรัพยากรที่ได้ทำรายการข้อมูลไว้เรียบร้อยแล้วในขั้นตอนการ
ทำตารางฐานข้อมูล 
 

 
• กดเลือกไฟล์ กดOpen และกด Continue รอข้อมูลทำการอัพโหลด 
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• จากนั้นไปตรงที่ Layout เพื่อจัดการกับ User interface (หน้าประสานงานกัลผู้ใช้) จะสังเกตได้ว่า
ข้อมูลที่ได้ทำในตาราง Excel ปรากฏ ในหน้า Layout ซึ่งสามารถกำหนดรูปแบบของหน้า Layout ได้ เช่น 
Card, List, Table, Calendar เป็นต้น 

- ซึ่ง Item แต่ละ Item ที่ปรากฏจะมีรายละเอียดของทรัพยากรแต่ละทรัพยากร ได้แก่ รูปภาพ ชื่อ
เรื่อง เลขทะเบียนทรัพยากร และประเภทของทรัพยากร ดังข้อมูลตารางไฟล์ Excel ที่ได้นำ Import เข้าไป 
 

 
 

• ในกรณีเพ่ิมเติมแก้ไขข้อมูลเพียงเล็กน้อยสามารถเพ่ิมได้โดยการเพ่ิมใน Data > New Row และกรอก
ข้อมูลเข้าไปได ้ 

• ซึ่งการนำข้อมูลเข้าก็สามารถทำได้ทั้ง Import file จาก Microsoft/Excel Google Sheet และใส่
รายการข้อมูลเข้าไปใน Data ของ Gildeapps ได้เลย 
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2.4 Work Flow ขั้นตอนแนวปฏิบัติสำหรับผู้ใช้งานระบบแอปพลิเคชัน Fofalib Movie  
ของห้องสมุดคณะวิจิตรศิลป์ ในการเพิ่มข้อมูลในแอปพลิเคชัน Fofalib Movie (GlideApps) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
หมายเหตุ: ขั้นตอนนีใ้ช้สำหรับเพิ่มและแกไ้ขข้อมูลในแอปท่ีสร้างไวแ้ล้ว 

 
 
 

 

บันทึกข้อมูล Title / Description / Type / Image เป็นไฟล์ข้อมลู Microsoft Excel (.xlsx) 
(0.5 วัน) 

ทางเลือกแหล่งข้อมูล: Import จาก Microsoft Excel (.xlsx)  
หรือกรอกข้อมูลโดยตรงใน Data ของ GlideApps 

 

สิ้นสุดการปฏบิัติงาน 

เริ่มต้นใช้งานแอปพลิเคชัน Fofalib Movie ด้วย https://www.glideapps.com/  

เริ่มต้น 

เลือกโปรเจกต์ “Fofalib’s App”  

เข้าแท็บ Data → กด Import → เลือกไฟล์ Excel (.xlsx) → Continue → รอระบบอัปโหลดข้อมูล 

ไปท่ีแท็บ Layout → เลือกรูปแบบการแสดงผล (เช่น Card, List, Table, Calendar) 

ตรวจสอบว่าแต่ละรายการแสดงรปูภาพ ช่ือเรื่อง เลขทะเบียน และประเภท ตามข้อมลูในตาราง 

กรณีปรับแก้/เพิม่บางรายการ 

0.5 วัน 
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2.5 ตารางท่ี 1 คำอธิบายขั้นตอนแนวปฏิบัติสำหรับผู้ใช้งานระบบแอปพลิเคชัน Fofalib Movie  
ของห้องสมุดคณะวิจิตรศิลป์ ในการเพิ่มข้อมูลในแอปพลิเคชัน Fofalib Movie (GlideApps)  
โดยมีลักษณะการปฏิบัติงานดังนี้ 
 

ลำดับ กระบวนการ รายละเอียดงาน ระยะเวลา ผู้รับผิดชอบ 

1. บันทึกข้อมูล  
Title / Description / Type / 
Image  
เป็นไฟล์ข้อมูล Microsoft Excel 

ใช้ Microsoft Excel 
ในการออกแบบตารางฐานข้อมลู และ
บันทึกเปน็ไฟล์ Excel Workbook 
(.xlsx)  

0.5 วัน 
เจ้าหน้าที่ห้องสมุด
คณะวิจิตรศิลป ์

2. เร่ิมต้นใช้งานแอปพลิเคชัน 
 Fofalib Movie ด้วย 
https://www.glideapps.com/  

ไปที่ https://www.glideapps.com/ 

→ Log in → Sign in with Email 
และกรอกอีเมล 

0.5 วัน 
เจ้าหน้าที่ห้องสมุด
คณะวิจิตรศิลป ์

3. เลือกโปรเจกต์ “Fofalib’s App”  เลือกโปรเจกต์ “Fofalib’s App” 
ตามที่ไดจ้ัดทำข้อมูลไว้ ใน GlideApps 

4. เข้าแท็บ Data → กด Import → 

เลือกไฟล์ Excel (.xlsx) → 

Continue →รอระบบอัปโหลดข้อมูล 

- 

5. ไปท่ีแท็บ Layout → 
เลือกรูปแบบการแสดงผล (เช่น Card, 
List, Table, Calendar) 

- 

6. ตรวจสอบว่าแต่ละรายการแสดง  
รูปภาพ ช่ือเรื่อง เลขทะเบียน 
และประเภท ตามข้อมลูในตาราง 

ตรวจสอบว่าแต่ละรายการแสดงรปูภาพ 

ช่ือเรื่อง เลขทะเบียน และประเภท 

ตามข้อมูลในตาราง Microsoft Excel 

ที่ได้บนัทึกไว ้

7. กรณีปรับแก้/เพิม่บางรายการ  
 

ไปท่ี Data → New Row 
หรือแก้ไขค่าที่เซลล์ได้ทันที 

8. ทางเลือกแหล่งข้อมูล: Import จาก 
Microsoft Excel (.xlsx) 
หรือกรอกข้อมูลโดยตรงใน Data ของ 
GlideApps 

 

- 
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บทที่ 3 
ปัญหาอุปสรรค แนวทางในการแก้ไขและพัฒนางาน 

 
เพ่ือให้การใช้งานระบบ Fofalib Movie เป็นไปอย่างราบรื่นและได้มาตรฐาน คู่มือนี้สรุปข้อเสนอแนะ 

ระบุปัญหา และอุปสรรคที่พบบ่อย และเสนอแนวทางแก้ไขและพัฒนางาน เพ่ือยกระดับความถูกต้อง ลดความ
ซ้ำซ้อน ลดข้อผิดพลาด และเพ่ิมประสิทธิภาพการให้บริการของห้องสมุดคณะวิจิตรศิลป์ 

 
3.1 ตารางท่ี 2 ข้อเสนอแนะ/ เทคนิคในการปฏิบัติงาน/ ปัญหาอุปสรรค แนวทางในการแก้ไขและพัฒนางาน 
 

ข้อเสนอแนะ/ เทคนิคในการปฏิบัติงาน/ 
ปัญหาอุปสรรค 

แนวทางในการแก้ไขและพัฒนางาน 

1.  รายช ื ่อทร ัพยากรสารสนเทศประเภท
ภาพยนตร์ไม่มีระบุในระบบแอปพลิเคชัน 
Fofalib Movie แต่พบที่ชั้นวางภาพยนตร์ 

สามารถติดต่อ นางสาวดิษวรรณ สุทัศน์สันติ 
โทรศัพท ์06-2246-9397  
Line official ของห้องสมุดคณะวิจิตรศิลป์ 
Line ID @304cffkc  

2. พบปัญหาในการใช้งานระบบแอปพลิเคชัน 
Fofalib Movie 

สามารถติดต่อ นางสาวดิษวรรณ สุทัศน์สันติ 
โทรศัพท ์06-2246-9397  
Line official ของห้องสมุดคณะวิจิตรศิลป์ 
Line ID @304cffkc 
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